Memory Stick IC Recorder

Operating Instructions

ICD-MS1

©2000 Sony Corporation
Owner’s Record

The model number is located at the rear panel and the serial number is located inside the battery compartment. Record the serial number in the space provided below. Refer to these numbers whenever you call upon your Sony dealer regarding this product.
Model No. ICD-MS1 Serial No. ______________

INFORMATION

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and receiver.
– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

You are cautioned that any changes or modifications not expressly approved in this manual could void your authority to operate this equipment.

Trademarks

• “Memory Stick” and are trademarks of Sony Corporation.
• “MagicGate Memory Stick” and are trademarks of Sony Corporation.
• IBM and PC/AT are registered trademarks of International Business Machines Corporation.
• Microsoft and Windows are trademarks of Microsoft Corporation, registered in the U.S.A. and other countries. Copyright ©1995 Microsoft Corporation. All rights reserved. Portion Copyright ©1995 Microsoft Corporation.
• Apple and Macintosh are trademarks of Apple Computer Inc., registered in the U.S.A. and other countries.
• Pentium is a registered trademark of Intel Corporation.

All other trademarks and registered trademarks are trademarks or registered trademarks of their respective holders.

This software uses software modules as shown below;
Microsoft® DCOM95 for Windows®95
©1999 Microsoft Corporation. All rights reserved.
Microsoft® DirectX® Media Runtime
©1998 Microsoft Corporation. All rights reserved.
# Table of Contents

## Overview
- What is the Memory Stick IC Recorder? ... 4
- What is “Memory Stick”? .................. 5
- Features of the ICD-MS1 IC Recorder .... 7
- About This Manual .......................... 8

## Getting Started
- Step 1: Installing the Battery ............ 9
- Step 2: Setting the Clock ................. 10
- Step 3: Inserting a “Memory Stick” into the IC Recorder .......... 11

## Basic Operations
- Recording Messages ...................... 12
- Playing Back Messages .................. 15
- Erasing Messages .......................... 17

## Various Ways of Playback
- Adjusting the Playback Speed .......... 19
- Playing the Beginning of Each Message — Scanning Play .................. 19
- Playing Repeatedly — Repeat Play ........ 20

## Editing Messages on the IC Recorder
- Adding a Recording ........................ 21
- Dividing a Message into Two/Combining Messages — Index Function .......... 22
- Adding /Deleting Folders ................. 24
- Moving Messages to a Different Folder .... 25
- Adding Priority Mark(s) — Priority Mark Function .......... 26
- Labeling Folders or Messages — Folder / Message Name .......... 27

## Other Functions
- Playing Back a Message at a Desired Time with an Alarm .......... 30
- Preventing Accidental Operation — HOLD function ............... 33
- Selecting the Display Mode .............. 34
- Formatting a “Memory Stick” .......... 35
- Changing IC Recorder Settings .......... 36
- Recording with an External Microphone or Other Equipment .... 37

## “Memory Stick Voice Editor” Software Operations
- Before Using the Software ............... 38
- Installing the Software .................... 40
- Connecting the “Memory Stick” to Your Computer .................. 41
- Starting Up the Software .................. 43
- Playing Back Messages on the Computer ............... 46
- Saving Messages to the Computer ...... 48
- Adding or Replacing Messages to the “Memory Stick” .......... 52
- Editing Messages in the “Memory Stick” on the Computer Screen .... 54
- Using the Menu Commands ............... 57

## Additional Information
- Precautions .............................. 60
- Troubleshooting ......................... 61
- System Limitations ....................... 64
- Error Messages ........................... 65
- Specifications ............................ 67
- Index to Parts and Controls ............. 68
- Menu Map ............................... 69
- Index .................................. 70

## Notes
- The illustrations in this manual may differ from the actual software.
- Explanations in this manual assume that you are familiar with basic operations of Windows 98 or Windows 95. For how to use your computer and operating system, please refer to the respective manuals.
What is the Memory Stick IC Recorder?

The Memory Stick IC recorder enables you to record and play back oral messages recorded on a “Memory Stick”.

Recording

When a new message is recorded, it is automatically added after the last recorded message. Unlike with tape recorders, you do not need to worry about recording over previously recorded messages by mistake. Since you do not need to search for the end of the last recording, you can start recording quickly whenever you wish.

Playback

With this IC recorder, you can quickly locate the message you want to play back. Reviewing the current recording is also very easy.

Erasing

You can quickly and easily erase unwanted messages. When a message is erased, the next message automatically advances, leaving no blank space.
What is “Memory Stick”?

What is “Memory Stick”?

“Memory Stick” is a new compact, portable and versatile IC recording medium with a data capacity that exceeds a floppy disk. “Memory Stick” is specially designed for exchanging and sharing digital data among “Memory Stick” compatible products. Because it is removable, “Memory Stick” can also used for external data storage.

One “Memory Stick” can be used to save and use images recorded by another unit as well as the voice messages using this unit.

The type of “Memory Stick” you can use with this IC Recorder

You can also use other “Memory Stick” instead of the supplied “Memory Stick” (16MB).

The maximum recording time varies depending on the capacity of the “Memory Stick”.

You can also use “MagicGate (MG) Memory Stick” the same as “Memory Stick”.

Note

“MagicGate” is a copyright protection technology that uses an encryption technology. This unit does not support the MagicGate standard, therefore, recorded data using this unit is not subject to the protection of copyrights by MagicGate.

Maximum recording time of a “Memory Stick”*

<table>
<thead>
<tr>
<th>Mode</th>
<th>4MB</th>
<th>8MB</th>
<th>16MB</th>
<th>32MB</th>
<th>64MB</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP</td>
<td>15 minutes</td>
<td>31 minutes</td>
<td>63 minutes</td>
<td>129 minutes</td>
<td>259 minutes</td>
</tr>
<tr>
<td>LP</td>
<td>31 minutes</td>
<td>65 minutes</td>
<td>131 minutes</td>
<td>267 minutes</td>
<td>537 minutes</td>
</tr>
</tbody>
</table>

* When using each “Memory Stick” for use with ICD-MS1 only and by the initial setting with three folders. The amount may change depending on use. For more information, see page 64.

On file format

This unit compresses voice data in “Memory Stick” voice format (MSV format, extension .msv). Voice data is saved in a VOICE folder in the “Memory Stick” together with message list (MSF) files that control voice data information (for example, the order of voice messages).

You can play back and edit voice messages recorded on a “Memory Stick” on a computer using the supplied “Memory Stick Voice Editor” software. See page 38 for details.

Note

When you connect the “Memory Stick” to your computer, you can check the contents using Windows Explorer. But use the supplied “Memory Stick Voice Editor” software to play back and edit messages.
What is “Memory Stick“? (Continued)

Notes on using a “Memory Stick“

• Recorded data may be lost or damaged in the following situations:
  – If you remove the "Memory Stick", turn the power off, or detach the battery for replacement when accessing.
  – If you use the "Memory Stick" near static electricity or electrical noise.
• We recommend backing up important data.

About formatting of a “Memory Stick“
The supplied “Memory Stick” is already formatted in FAT format. Use “Memory Stick” compatible devices to format a “Memory Stick”. To format using this unit, see page 35.

Note
If you format the “Memory Stick” using the computer, further operation with this unit is not guaranteed.

Backup recommendations
To avoid potential risk of data loss caused by accidental operation, damage of the “Memory Stick”, or malfunction of the IC recorder, we recommend that you save a backup copy of your recorded messages on a tape recorder or to a computer, etc.
You can transfer and save the messages in the “Memory Stick” to your computer using the supplied “Memory Stick Voice Editor“ software.
Features of the ICD-MS1 IC Recorder

63 minutes (SP)/131 minutes (LP) recording time (using the supplied 16MB “Memory Stick”) and recording up to 965 messages*1)

This unit is suitable for recording long meetings or lectures.

Up to 340 folders*2) can be created to save messages

Labeling folders and messages (page 27)

You can label folders and messages yourself. Folder names can be selected from templates names. You can also label them using the supplied “Memory Stick Voice Editor” software.

Various record, playback, and edit functions

- **Cue/Review function (page 16)**
  You can quickly search for the desired parts during playback using the cue or review function. The unit searches at slow speed at first, then at faster speed.

- **Overwrite and additional recording function (page 21)**
  You can overwrite after the desired point on a recorded message or add a new recording to a previously recorded message.

- **Repeat play function (page 20)**
  This unit can play back one message or the selected section repeatedly.

- **Playback speed control (page 19)**
  You can play back messages rapidly (Fast playback) or slowly (Slow playback). This is useful when playing back a long recording such as a meeting.

- **Alarm function (page 30)**
  You can start playing back a desired message with an alarm on a desired date and time.

- **Index function (page 22)**
  You can divide a message into two and combine messages.

- **Priority Mark function (page 26)**
  You can add priority marks. Messages can be sorted in order of the number of priority marks.

LCD window with back light (page 34)

The supplied “Memory Stick Voice Editor” software (page 38)

You can transfer the messages recorded in “Memory Stick” to the computer with the supplied “Memory Stick Voice Editor” software.

---

*1) When using the supplied “Memory Stick” (16MB) for use with ICD-MS1 only and by the initial setting with three folders.

*2) When using the supplied “Memory Stick” (16MB) for use with ICD-MS1 only when one recorded message is in each folder.
About This Manual

There are following sections in this manual.

• **Getting Started (page 9)**
  Preparation for using the IC Recorder

• **Basic Operations (page 12)**
  Basic operations of the IC Recorder (Recording, playing back and erasing messages)

• **Various Ways of Playback (page 19)**
• **Editing Messages on the IC Recorder (page 21)**
• **Other Functions (page 30)**
  Advanced operations of the IC Recorder

• **“Memory Stick Voice Editor“ Software Operations (page 38)**
  Basic operations when connecting the “Memory Stick” to a computer with the supplied software installed.

• **Additional Information (page 60)**
  Troubleshooting, precautions, menu map, etc.

Using online Help files of the software

For details on how to use the supplied “Memory Stick Voice Editor” software, refer to the online Help files (available in English only).

For the latest information, refer to the “readme.txt” file. To open the file, click [Start], [Programs], [Memory Stick Voice Editor], and then [ReadMe].

To open online Help files

There are three ways to open online Help files as follows;
• Click [Start], [Programs], [Memory Stick Voice Editor], and then [Help].
• After starting up the software, select [Help Topics] in the [Help] menu.
• After starting up the software, click 📖 (Help topics) in the Toolbar.
Getting Started

Step 1: Installing the Battery

1. Slide and lift the battery compartment lid.

2. Insert two size AAA (LR03) alkaline batteries with correct polarity, and close the lid.

Clock setting display appears when you insert batteries for the first time, or when you insert batteries after the unit has been without batteries for a certain period of time. Please refer to Steps 4 to 5 in “Step 2: Setting the Clock” on page 10 to set the date and time.

Note
If the battery compartment lid is accidentally detached, attach it as illustrated.

Replacing the batteries
The battery indicator in the display window shows the battery condition as follows:

When "LOW BATTERY" is displayed, replace the batteries with new ones.

Notes
• Do not use manganese batteries for this unit.
• When you replace the batteries, insert the new ones within 3 minutes after you removed the exhausted ones. Otherwise, the display may show the clock setting display or incorrect date and time when you reinsert the batteries. In this case, set the date and time again.
• When replacing the batteries, be sure to replace both batteries with new ones.
• Do not charge dry batteries.
• When you are not going to use the unit for a long time, remove the batteries to prevent damage from battery leakage and corrosion.

Battery life*
With continuous use, approx. 5 hours recording/4 hours playback
* Using Sony alkaline batteries LR03 (SG)
* When playing back through the internal speaker with VOL control at around 4
The battery life may shorten depending on the operation of the unit.

Using on house current
Connect the AC power adaptor AC-E30HG (not supplied) to the DC IN 3V jack of the unit and to the wall outlet.

Do not use any other AC power adaptor.

Note
If the battery compartment lid is accidentally detached, attach it as illustrated.

Polarity of the plug
Step 2: Setting the Clock

You need to set the clock to use the alarm function or record the date and time. Clock setting display appears when you insert battery for the first time, or when you insert battery after the unit has been without battery for a certain period of time. In this case, proceed from step 4.

1. Press MENU button. The menu mode will be displayed in the display window.

2. Press the jog lever up once to select “DATE&TIME”.

3. Press the jog lever. The year digits will flash.

4. Set the date and time.
   ① Press the jog lever up or down to select the digits of the year.

   ![DATE&TIME display]

   ② Press the jog lever. The month digits will flash.

   ![DATE&TIME display]

   ③ Set the month, day, and the time in sequence, then press the jog lever. The menu mode will be displayed again.

5. Press MENU button. Exit from the menu mode.

To display the current time
Press STOP button during the sleep display mode (page 34). The current time will be displayed for three seconds.
Step 3: Inserting a “Memory Stick” into the IC Recorder

Insert a “Memory Stick” into the Memory Stick slot in the direction of ▲ on the “Memory Stick” as shown below.

Notes
• Make sure to insert the “Memory Stick” firmly.
• Do not insert a “Memory Stick” in a different direction. It may cause malfunction of the unit.

After inserting a “Memory Stick”
The following display will appear. If you insert a “Memory Stick” for the first time after purchasing or one with no data, three folders (FOLDER01, FOLDER02, FOLDER03) will be made in the “Memory Stick” automatically.

Note
The unit is accessing while “ACCESS” appears in the display window or the OPR indicator flashes in orange. While accessing, do not remove the “Memory Stick”, batteries, or the AC adaptor. Doing so may damage the data.

About write-protect of a “Memory Stick”
You cannot record or erase data when the write-protect switch on the “Memory Stick” is set to “LOCK”.

Removing the “Memory Stick”
Slide the EJECT lever in the direction of the arrow and remove the “Memory Stick” from the slot as shown below.
Recording Messages

You can record up to 63 (SP mode)/131 (LP mode) minutes, up to 965 messages, using the supplied Memory Stick (16MB)*. Recorded messages are saved in folders. You can make folders (3 folders already made as a default setting).

* When using the supplied “Memory Stick” for use with ICD-MS1, three folders are set as the default setting. The maximum recording time and the number of messages you can make vary depending on the conditions or capacity of the “Memory Stick”. For more information, see page 64.

* SP mode is set as the default setting. The maximum recording time ranges from 63 minutes to 131 minutes when messages are saved in both SP and LP modes.

Note
Before making a long recording, be sure to insert new batteries and check the battery indicator (page 9). You can also use the optional AC adaptor by connecting it to the DC IN 3V jack instead of using batteries. For more information, see page 9.

1. Select the folder *.

2. Start recording.

3. Stop recording.

Note on recording
Noise may be recorded if an object, such as your finger, etc., accidentally rubs or scratches the unit during recording.

Note
Before making a long recording, be sure to insert new batteries and check the battery indicator (page 9). You can also use the optional AC adaptor by connecting it to the DC IN 3V jack instead of using batteries. For more information, see page 9.

* The display selected with the DISPLAY button (page 34) appears.

** You can select folders using the jog lever after pressing the FOLDER button.

** You can select folders using the jog lever after pressing the FOLDER button.
To stop recording
You can also stop recording by pressing the STOP button instead of the ●REC/STOP button.

To change the recording mode
See page 34.

To select the microphone sensitivity
You can select the microphone sensitivity by switching the MIC SENS selector on the rear of the unit.
H (high): To record at meetings or in a quiet and/or spacious place.
L (low): To record dictation or in a noisy place.

Recording with an external microphone or from other equipment
See page 37.

Other operations

To listen to the current recording
Press ●REC/STOP button or STOP button to stop recording, then press the jog lever.

To review the current recording instantly
Press the jog lever during recording.

To monitor the recording
Connect an earphone or headphones (not supplied) to the 〔earphone〕 jack.
You can adjust the volume with the VOL control, but the recording level is fixed.

Note
If you turn up the volume excessively or place the earphone near the microphone while monitoring the recording, the microphone may pick up the sound from the earphone, causing acoustic feedback (howling sound).

To pause recording

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>pause recording*</td>
<td>Press ⅱ(pause) button. During recording pause, the OPR indicator flashes in red and “PAUSE” flashes in the display window.</td>
</tr>
<tr>
<td>release pause and resume recording</td>
<td>Press ⅱ(pause) button or ●REC/STOP button. Recording resumes from that point. (To stop recording after pausing recording, press STOP button.)</td>
</tr>
</tbody>
</table>

* About one hour after you pause recording, recording pause is automatically released and the unit goes into the stop mode.

Continued
Recording Messages (continued)

Remaining memory indication
During recording, the remaining memory indicator decreases one by one. You can check the remaining recording time by changing to the remaining time display mode (page 34).

When the remaining recording time reaches 5 minutes, the remaining memory indication flashes. When the remaining time reaches 1 minute, the remaining time indication will flash in the display window regardless of the display mode (page 34). When the memory is full, recording automatically stops and “NO MEMORY SPACE” will flash in the display window with an alarm sound. To continue recording, first erase some of the messages (page 17).

To review during recording
If you press the jog lever up during recording, recording stops and you can search backwards while listening to fast playback sound. After you release the jog lever, playback starts from that point. You can also do this operation during recording pause. However, you cannot hear the sound during review in this case.

Starting Recording Automatically in Response to the Sound — Advanced VOR function
When the VOR (voice operated recording) function is set to on, recording starts when the recorder detects sound and stops when no sound is heard.

When you record messages with VOR set to ON, the recording pauses when no sound is detected, and “VOR REC PAUSE” appears in the display window.

To cancel VOR
Set the VOR selector to OFF.

Note
VOR function is affected by the sound around you. Set the MIC SENS selector to either H or L (see the previous page). If recording is not satisfactory after you have changed the microphone sensitivity, or for important recording, set the VOR selector to OFF.
### Playing Back Messages

To play back a previously recorded message, start from Step 1.

To play back a message you have just finished recording, start from Step 3.

1. Select the folder *.

2. Select the message number.

3. Start playback.

4. Adjust the volume.

---

**For private listening**

Connect an earphone or headphones (not supplied) to the \( \oplus \) (earphone) jack. The built-in speaker will be automatically disconnected.

If you plug in headphones, you will get monaural output from both the left and right channels.

---

*The display selected with the DISPLAY button (page 34) appears.*

### Basic Operations

---

* The display selected with the DISPLAY button (page 34) appears.
Playing Back Messages (continued)

Other operations

To stop playback

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>stop at the beginning of the current message</td>
<td>Press STOP.</td>
</tr>
<tr>
<td>stop at the current position (Playback Pause function)*</td>
<td>Press the jog lever. To resume playback from that point, press the jog lever again.</td>
</tr>
</tbody>
</table>

* You can also pause playback by pressing \(\text{II}(\text{pause})\) instead of the jog lever. The OPR indicator will flash in green. After about one hour, the unit goes into the stop mode at the current position.

To select the desired message

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>go back to the beginning of the current message</td>
<td>Press the jog lever up once and release it.</td>
</tr>
<tr>
<td>go back to previous messages</td>
<td>Press the jog lever up several times and release it.</td>
</tr>
<tr>
<td>skip to the next message</td>
<td>Press the jog lever down once and release it.</td>
</tr>
<tr>
<td>skip to the succeeding messages</td>
<td>Press the jog lever down several times and release it.</td>
</tr>
</tbody>
</table>

Tip
When playback is done to the end of the last message, “MSG. END” flashes for 3 seconds and the OPR indicator lights up in green. (You cannot hear the playback sound.) If you keep pressing the jog lever up while “MSG. END” is flashing, the messages will be played back rapidly, and normal playback will start at the point you release the jog lever.

When “MSG. END” stops flashing and the OPR indicator goes off, the unit will stop at the beginning of the last message.

If the last message is long and you wish to start playback at a later part of the message, keep pressing the jog lever down to play back the message to the end and then press the jog lever up while “MSG. END” is flashing to go back to the desired point.

(For messages other than the last one, go to the beginning of the next message and play backward to the desired point.)

Playing the beginning of each message — Scanning Play
See page 19.

Playing back all messages in a folder continuously — Continuous Play
See page 37.

Searching forward/backward during playback (Cue/Review)

• To search forward
Keep pressing the jog lever down during playback and release it at the point you wish to resume playback.

• To search backward
Keep pressing the jog lever up during playback and release it at the point you wish to resume playback.

The unit searches at slow speed (unit of 4 seconds) with playback sound. It is useful to check one word forward or behind.

Then, if you keep pressing the jog lever up or down, the unit starts to search at higher speed.

During cue/review, the counter will be displayed, regardless of the display mode setting (page 34).

You can cue/review during playback pause.
Press the jog lever up or down and release it at the point you want to resume playback pause.
### Erasing Messages

You can erase the recorded messages one by one or all messages in a folder at a time. Note that once a recording has been erased, you cannot retrieve it.

#### Erasing messages one by one

When a message is erased, the remaining messages will advance and be renumbered so that there will be no space between messages.

**Before erasing message3**

<table>
<thead>
<tr>
<th>Message 1</th>
<th>Message 2</th>
<th>Message 3</th>
<th>Message 4</th>
</tr>
</thead>
</table>

**After erasing**

<table>
<thead>
<tr>
<th>Message 1</th>
<th>Message 2</th>
<th>Message 3</th>
</tr>
</thead>
</table>

1. **Press ERASE button** while playing back the message you want to erase or press ERASE button for more than 1 second during stop mode. The message number and “ERASE” will flash while the first and last 5 seconds of the message is played back 10 times.

2. **Press ERASE button** while the message is being played back. The message is erased and the remaining messages will be renumbered. (For example, if you erase Message 3, Message 4 will be renumbered as Message 3. When erasing is completed, the unit will stop at the beginning of the following message.)

   ![Folder 01 003/024 SP 00000000](image)

**To cancel erasing**

Press STOP before step 2.

**To erase other messages**

Repeat steps 1 and 2.

**To erase a message partially**

First divide the message by adding an index (see page 21) and then follow the steps on this page to erase the message.

**Note**

An error message will be displayed in the display window when you cannot erase a message. For more information, see “Troubleshooting” (page 61).
Erasing Messages (continued)

Erasing all messages in a folder

You can erase all recorded messages in a folder, but the folder itself will not be deleted. If you want to delete a folder, see page 24.

1 Select the folder containing the messages you want to erase.
   For more information see Step 1 of “Recording Messages” (page 12).

2 While pressing STOP button, press ERASE button for more than 1 second.
   “ERASE ALL” will flash for 10 seconds.

3 While the display is flashing, press ERASE button.

To cancel erasing
Press STOP before step 3.

Notes
- While “ERASE ALL” is displayed in the display window or the OPR indicator flashes in orange, do not remove the “Memory Stick”, batteries, or the AC adaptor. This may damage the data.
- An error message will appear in the display window when you cannot erase all messages in a folder. For more information, see “Troubleshooting” (page 61).
Various Ways of Playback

Adjusting the Playback Speed

You can adjust the speed of the playback with the use of the PLAY SPEED selector on the rear of the unit.

To play back rapidly
Set PLAY SPEED to FAST.
When playback starts, “FAST PLAY” will flash three times in the display window and the messages will be played back about 20% in SP mode or 30% in LP mode faster than normal.

To play back slowly
Set PLAY SPEED to SLOW.
When playback starts, “SLOW PLAY” will flash three times in the display window and the messages will be played back about 15% slower than normal.

To play messages at normal speed
Set PLAY SPEED to NORMAL.

Tip
You can change the playback speed during playback.

Playing the Beginning of Each Message
— Scanning Play

During stop mode, press the jog lever for more than one second. “SCAN PLAY” will be displayed in the display window and the first 5 seconds of each message in the selected folder will be played back.

When you find the desired message, press the jog lever. The entire message will be played back.

To resume normal playback
Press the jog lever. To stop playback, press STOP button.
Playing Repeatedly — Repeat Play

Playing back one message repeatedly — One Message Repeat

During playback, press the jog lever for more than one second.
“将持续播放” will be displayed and the selected message will be played back repeatedly.

To resume normal playback
Press the jog lever again. To stop playback, press STOP button.

Playing back the specified section repeatedly — A-B Repeat

While playing back a message, you can set the start (A) and end (B) points for a section you want to play repeatedly.

1 Press A-B REPEAT / PRIORITY button briefly during the playback. The starting point (A) of the section you want to play repeatedly is set. “A-B B?” will be displayed on the screen.

2 Press A-B REPEAT / PRIORITY button briefly again. The finishing point (B) of the section is set. "A-B REPEAT" will be displayed on the screen and the specified section will play repeatedly.

Notes
- You cannot set A-B Repeat for a section that overlaps two or more messages.
- If you do not set the finishing point (B), the finishing point is set automatically at the ending point (or beginning point) of the message.

If you set the finishing point ahead of the starting point by reviewing, the section is played from the finishing point (B) to the starting point (A).

You can reset the points of the section of A-B Repeat by pressing A-B REPEAT / PRIORITY button during A-B Repeat play.

To resume normal playback
Press the jog lever. To stop playback, press STOP button.
Adding a Recording

You can add a recording to the message being played back.
The added recording will be placed after the current message and counted as a part of the message.

1 During playback, press \[REC/STOP\] button for more than 1 second.
The “ADD REC” indicator appears and flashes three times on the display window.
The OPR indicator will turn red.
The new recording will be added at the end of the current message.

2 Press \[REC/STOP\] button or STOP button to stop the recording.

Adding an Overwrite Recording during Playback

You can add an overwrite recording after the selected point in a recorded message. The part of the message after the selected point is deleted.

1 During playback, press \[REC/STOP\] button briefly.
The “OVER WRITE?” indicator appears and flashes on the display window.
The OPR indicator will flash red.

2 Press \[REC/STOP\] button to start recording
The OPR indicator will turn red.

3 Press \[REC/STOP\] button or STOP button to stop the recording.

Note
- The added message will be recorded in the same recording mode (SP or LP; see page 36) as the original message, regardless of the current recording mode setting.
- You cannot overwrite if the remaining memory of the “Memory Stick” is not long enough. For more information, see “Troubleshooting” (page 61).
Dividing a Message into Two / Combining Messages — Index Function

You can divide a message by adding an index, or combine messages by erasing the index.

While recording / playing back messages, you can add an index (see below). In stop mode, you can erase the index (see the next page).

Dividing a Message by Adding an Index

You can add an index to a message during recording or playback.

By dividing a message, you can easily find the point you want to play back when you make a long recording such as a meeting.

When you add an index, the message numbers will increase as follows.

<table>
<thead>
<tr>
<th>Message 1</th>
<th>Message 2</th>
<th>Message 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>An index is added.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

An index is added.

<table>
<thead>
<tr>
<th>Message 1</th>
<th>Message 2</th>
<th>Message 3</th>
<th>Message 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>The first item on the agenda is...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>We will now proceed to the next subject.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To mark an index during recording

While recording a message, press INDEX button at the point you want to divide.

The new message number is added at the point you pressed INDEX button, and “ADD INDEX” flashes three times. The message will be divided in two messages; however, the messages will be recorded without a break.

An index is added.

To add an index during playback

While playing back a message, press INDEX button at the point you want to divide.

The message is divided in two and “ADD INDEX” flashes three times.

An index mark is added and the following index numbers will increase by one.

To play the message you marked with an index

Press the jog lever up or down to display the message number as the divided messages each have message numbers.
To play the divided messages continuously

Select “ON” for “CONT.” as described in “Playing Back All Messages in a Folder Continuously” on page 37.

Notes

• You need a certain amount of space in the “Memory Stick” to add an index. For more information, see “System Limitations” on page 64.
• You cannot add an index when “INDEX FULL” appears in the display window. Erase some messages before adding an index. For more information, see “System Limitations” on page 64.
• The recorded date and time (page 34) of the latter part of the divided message by adding an index, is the same as that (the starting date and time of recording) of the divided message.
• If you add an index to a labeled message (page 28) that was divided, the other part of the divided message will have the same message name.
• If you add an index to a message with priority mark(s) (page 26), priority mark(s) will be added to both parts of the divided message.

Combining messages by erasing the index

You can combine two messages by erasing the index.

The index is erased.

<table>
<thead>
<tr>
<th>Message 1</th>
<th>Message 2</th>
<th>Message 3</th>
<th>Message 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message 1</td>
<td>Message 2</td>
<td>Message 3</td>
<td>Message 4</td>
</tr>
</tbody>
</table>

The message numbers decrease.

In stop mode, follow the steps below:

1. Press the jog lever up or down to display the number of the second of the two messages you want to combine.

2. While pressing ERASE button, press INDEX button for more than 1 second.

   “ERASE INDEX” will flash for 10 seconds.

3. Press ERASE button while the display is flashing.

   The two messages are combined into one and the messages will be renumbered as in the illustration above.

Notes

• After combing messages by erasing an index, the latter message’s name (page 28), alarm setting (page 30), priority mark(s) (page 26), and the recorded date and time (page 34) will be deleted.
• You cannot combine messages with different recording modes.

To cancel erasing

Press STOP button before step 3.
Adding / Deleting Folders

By default setting, there are three folders: “FOLDER01”, “FOLDER02”, and “FOLDER03”. You can add folders as you like up to a maximum of 511. You can also delete unnecessary folders.

Note
The maximum number of folders you can add varies depending on the capacity of a “Memory Stick” or using conditions. “FOLDER FULL” is displayed in the display window when you cannot add any folder because of the system limitations of the IC recorder (page 64). You can make up to 340 folders when you use the supplied “Memory Stick” (16MB) as use for this IC Recorder only and there is one message in each folder.

Adding Folders
Press FOLDER button for more than 1 second.
“NEW FOLDER” will be displayed on the display and a folder will be added.

About added folder names
The new folder is labeled automatically with double figures or letter like “FOLDER 04” or “FOLDER AB”. If there is a missing number or letter among the folder names, the new one is labeled using the missing number or letters automatically.
You can change the folder name as you like (page 27).

Deleting Folders
You can only delete a folder that has no recorded messages.

1 Select the folder you want to delete. For information on selecting a folder, see step 1 of “Recording Messages” on page 12.

Note
You cannot delete a folder that has some recorded messages. First, erase all messages in the folder (see page 17) or move them (see the next page).

2 Press ERASE button for more than 1 second while pressing STOP button. “ERASE FOLDER” will flash for ten seconds on the display.

3 Press ERASE button while the display is flashing. The folder will be deleted.

To cancel deleting
Press STOP button before step 3.

Notes
• You cannot delete the last folder left in a “Memory Stick”.
• After deleting a folder, the name of other folders are not changed. If “FOLDER 03” is erased, the name of “FOLDER 04” will remain the same.
Moving Messages to a Different Folder

You can move the recorded messages to another folder.

Example: Moving Message 3 in FOLDER 02 to FOLDER 03.

1. Play back the message you want to move.

2. While playing back the message, press FOLDER button.
   The first and last 5 seconds of the message will be played back 10 times, while “MOVE MSG.” is displayed and flashes and the destination folder with a black background.

3. Press the jog lever up or down to select the folder you want to move the message into and press the jog lever.
   The message is moved in the destination folder.
   Messages are sorted in order of the recorded date and time or the number of the priority marks in the folder.

To cancel moving the message
Press STOP button before step 3.

Note
The move function does not duplicate a message in another folder. When you move a message to another folder, the one in the previous folder will be deleted.
Adding Priority Mark(s) — Priority Mark Function

You can add priority mark(s) to the desired message to sort messages by the number of priority marks instead of the recorded date and time. There are four levels, "vvvv" (the most important), "vv", "v", and no priority mark. You can add priority marks both in the stop mode and in playback mode.

To add priority mark(s) in the stop mode

1. Select the message you want to mark.
2. Press A-B REPEAT / PRIORITY button for more than 1 second. "v" and "PRIORITY" will flash on the display window.
3. Press A-B REPEAT / PRIORITY button repeatedly to select the number of priority mark(s) while "PRIORITY" is flashing. The setting is finished when "v" lights steadily in the display window. The messages will be renumbered.

To add priority mark(s) during playback

1. Press A-B REPEAT / PRIORITY button for more than 1 second during playback of the message you want to mark. "▲" and "PRIORITY" will flash on the display window while the first and last 5 seconds of the message is played back 10 times.
2. Press the jog lever up or down to select the number of priority mark(s) during flashing.
3. Press the jog lever to fix the setting. The setting is finished and the messages will be renumbered.

Messages with priority mark(s)

Messages are sorted in order of the number of priority marks in a folder. Messages without a priority mark are moved after messages with priority mark(s).

☞ Tip
If there are over 2 messages with the same number of priority marks in a folder, these messages will sorted by the recorded date and time (The older one comes first).

Note
You can also add priority mark(s) using the supplied “Memory Stick Voice Editor” software (page 56). But messages are not sorted in order of the number of the priority marks unless you sorted by the number of priority marks using the software.
Labeling Folders or Messages — Folder / Message Name

You can label folders or messages yourself.

Tip
You can also label folder or messages using the supplied “Memory Stick Voice Editor” software. For more information, see page 54.

Labeling folders

Folders have been labeled automatically like "FOLDER03", but you can label folders as you like by using template names or creating on your own.

1 Press MENU button.
Enter the menu mode.

2 Press the jog lever up or down to select “FOLDER NAME”.

3 Press the jog lever.

4 Press the jog lever up or down to select “TEMPLATES” or “ALPHABET” and press the jog lever.

5 To select a folder name from templates:
Press the jog lever up or down to select a template name and press the jog lever to set the name.

Registered template names
ACTION, SCHEDULE, MEETING, OFFICE, HOME, MEMO, REPORT, SPEECH, INTERVIEW, TRAVEL, PERSONAL, PLACE, SHOP LIST, CLASS, MESSAGE, EXPENSE

To enter characters:
You can enter up to 44 characters to label a folder.

The cursor flashes after the last character of the current folder name. You can add after the current name or change it.
To enter characters, see page 28.

6 Press the jog lever for more than one second to fix the name.

7 Press the MENU button.
Exit from the menu mode.

Continued
Labeling Folders or Messages (Continued)

 Longer folder names
The display window can display up to 10 characters only.
If the name is more than 10 characters, it can be read by scrolling in the display window when the folder name is selected (see step 1 on page 12 or 15).
The name cannot be scrolled in other display windows.

 To cancel labeling
Press STOP button.

Labeling messages
Messages are not labeled automatically, but you can label messages yourself.

1 Press MENU button.
Enter the menu mode.

2 Press the jog lever up or down to select “MSG. NAME”.

3 Press the jog lever.

4 Enter characters.
You can enter up to 254 characters to label a message.

5 Press the jog lever for more than one second to fix the name.

6 Press MENU button.
Exit from the menu mode.

 Longer message names
The display window can display up to 10 characters only.
If the name is longer, it can be scrolled when changing display modes or during playback of the message.

 To cancel labeling
Press STOP button.
To enter characters

Follow the steps below when the display prompts to enter characters (when the cursor is flashing in step 5 for labeling a folder on page 27 or in step 4 for labeling a message on the previous page).

To enter characters

1. Press the jog lever up or down to select the desired character.
   - See the order of character sets on the next page.
2. Press the jog lever briefly to fix.
   - The cursor moves to the next.
3. Repeat steps 1 and 2 to enter other characters.

To replace characters

When you make a mistake in entering a character or when you want to change the name, enter again after all characters have been deleted by pressing ERASE button for more than one second or replace some of the characters as follows.

1. Place the cursor at the character you want to change.
   - To move the cursor back (to the left), press INDEX button briefly.
   - To move the cursor forward (to the right), press the jog lever briefly.
2. Press the jog lever up or down to select the desired character.
3. Press the jog lever to move the cursor forward and repeat steps 1 and 2 to change other characters.

Note

You cannot insert a character into a name. You must simply replace all the characters following the character you want to insert.

Using the jog lever and buttons when labeling a folder / message

<table>
<thead>
<tr>
<th>Do this</th>
<th>To do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press the jog lever briefly</td>
<td>Set a character (The cursor moves the next).</td>
</tr>
<tr>
<td>Press the jog lever for more than 1 second</td>
<td>Set the name (Finishing entering the name).</td>
</tr>
<tr>
<td>Press the jog lever down briefly</td>
<td>Select characters (move to the next).</td>
</tr>
<tr>
<td>Press the jog lever down for more than 1 second</td>
<td>Select characters (move to the next quickly).</td>
</tr>
<tr>
<td>Press the jog lever up briefly</td>
<td>Select characters (return to the previous).</td>
</tr>
<tr>
<td>Press the jog lever up for more than 1 second</td>
<td>Select characters (return to the previous ones quickly).</td>
</tr>
<tr>
<td>Press ERASE briefly</td>
<td>Erase a character.</td>
</tr>
<tr>
<td>Press ERASE for more than 1 second</td>
<td>Erase all characters.</td>
</tr>
<tr>
<td>Press DISPLAY briefly</td>
<td>Change character sets.</td>
</tr>
<tr>
<td>Press INDEX briefly</td>
<td>The cursor moves back.</td>
</tr>
</tbody>
</table>

Character sets

<table>
<thead>
<tr>
<th>Order</th>
<th>Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Capital letters)</td>
<td>A B C D ~ X Y Z</td>
</tr>
<tr>
<td>2 (Symbol 1)</td>
<td>' , / : (space)</td>
</tr>
<tr>
<td>3 (Small letters)</td>
<td>a b c d ~ x y z</td>
</tr>
<tr>
<td>4 (Symbol 1)</td>
<td>' , / : (space)</td>
</tr>
<tr>
<td>5 (Numbers)</td>
<td>0 1 2 ~ 8 9</td>
</tr>
<tr>
<td>6 (Symbol 2)</td>
<td>! # $ % &amp; ( ) * ; &lt; = &gt; ? @ _ ‘ + - , / : (space)</td>
</tr>
</tbody>
</table>
Other Functions

Playing Back a Message at a Desired Time with an Alarm

You can sound an alarm and start playback of a selected message at a desired time.

You can use this function to remind you of the date and time of a meeting, etc.

1. Select the message you want to play back.
   For more information about selecting the desired message, see step 1 and 2 of “Playing Back Messages” on page 15.

2. Enter the alarm setting mode.
   ① Press MENU button.
      The menu mode will be displayed in the display window.

      JOG LEVER

      MENU

      DATE & TIME
      ALARM OFF
      MODE SP

      Tip
      If “ALARM” is not selected after pressing MENU button, press the jog lever up or down to select “ALARM”.

3. Press the jog lever.
   The alarm setting mode will be displayed in the display window.

4. Press the jog lever up or down to select “ON”.
   If “ON” has already been selected, follow the next steps.

5. Press the jog lever.
   “DATE” will be displayed in the display window.

6. Set the alarm date and time.

   To play back on a desired date
   ① Press the jog lever while “DATE” is flashing.
      The year digits will flash.

   ② Press the jog lever up or down to select the year digits and press the jog lever.
      The month digits will flash.

   ③ Set the month, day, and the time in sequence, then press the jog lever.

Other Functions

Playing Back a Message at a Desired Time with an Alarm

You can sound an alarm and start playback of a selected message at a desired time.

You can use this function to remind you of the date and time of a meeting, etc.

1. Select the message you want to play back.
   For more information about selecting the desired message, see step 1 and 2 of “Playing Back Messages” on page 15.

2. Enter the alarm setting mode.
   ① Press MENU button.
      The menu mode will be displayed in the display window.

   ② Press the jog lever up or down to select “ON”.
      If “ON” has already been selected, follow the next steps.

   ③ Press the jog lever up or down to select “DATE”.
      If “ON” has already been selected, follow the next steps.

   ④ Press the jog lever.
      “DATE” will be displayed in the display window.

3. Set the alarm date and time.

   To play back on a desired date
   ① Press the jog lever while “DATE” is flashing.
      The year digits will flash.

   ② Press the jog lever up or down to select the year digits and press the jog lever.
      The month digits will flash.

   ③ Set the month, day, and the time in sequence, then press the jog lever.

Other Functions

Playing Back a Message at a Desired Time with an Alarm

You can sound an alarm and start playback of a selected message at a desired time.

You can use this function to remind you of the date and time of a meeting, etc.

1. Select the message you want to play back.
   For more information about selecting the desired message, see step 1 and 2 of “Playing Back Messages” on page 15.

2. Enter the alarm setting mode.
   ① Press MENU button.
      The menu mode will be displayed in the display window.

   ② Press the jog lever up or down to select “ON”.
      If “ON” has already been selected, follow the next steps.

   ③ Press the jog lever up or down to select “DATE”.
      If “ON” has already been selected, follow the next steps.

   ④ Press the jog lever.
      “DATE” will be displayed in the display window.

3. Set the alarm date and time.

   To play back on a desired date
   ① Press the jog lever while “DATE” is flashing.
      The year digits will flash.

   ② Press the jog lever up or down to select the year digits and press the jog lever.
      The month digits will flash.

   ③ Set the month, day, and the time in sequence, then press the jog lever.

Other Functions

Playing Back a Message at a Desired Time with an Alarm

You can sound an alarm and start playback of a selected message at a desired time.

You can use this function to remind you of the date and time of a meeting, etc.

1. Select the message you want to play back.
   For more information about selecting the desired message, see step 1 and 2 of “Playing Back Messages” on page 15.

2. Enter the alarm setting mode.
   ① Press MENU button.
      The menu mode will be displayed in the display window.

   ② Press the jog lever up or down to select “ON”.
      If “ON” has already been selected, follow the next steps.

   ③ Press the jog lever up or down to select “DATE”.
      If “ON” has already been selected, follow the next steps.

   ④ Press the jog lever.
      “DATE” will be displayed in the display window.

3. Set the alarm date and time.

   To play back on a desired date
   ① Press the jog lever while “DATE” is flashing.
      The year digits will flash.

   ② Press the jog lever up or down to select the year digits and press the jog lever.
      The month digits will flash.

   ③ Set the month, day, and the time in sequence, then press the jog lever.
**To play back once a week**

1. Press the jog lever up or down to select the day of the week.

2. Press the jog lever. The hour digits will flash.

3. Press the jog lever up or down to select the hour digits, and press the jog lever. The minute digit will flash.

4. Press the jog lever up or down to select the minute digits, and press the jog lever.

**To play back at the same time every day**

1. Press the jog lever up or down to select “DAILY”.

2. Press the jog lever. The hour digits will flash.

3. Press the jog lever up or down to select the hour digits, and press the jog lever. The minute digit will flash.

4. Press the jog lever up or down to select the minute digits, and press the jog lever.

4. Select the alarm sound. Press the jog lever up or down to select "BEEP & PLAY" or "BEEP ONLY" and press the jog lever.

5. Press MENU button. Exit the menu mode. "(m)" is displayed when the message having an alarm setting is selected.

**When the set date and time comes**

At the set time, the alarm will sound for about 10 seconds and the selected message will be played back (If you have selected “BEEP ONLY” in step 4, only the alarm will sound).

During alarm playback, “ALARM” will flash in the display window.

When the playback ends, the unit will stop automatically at the beginning of that message.

**To listen to the same message again**

Press the jog lever. The same message will be played back from the beginning.

**To cancel the alarm setting before the playback starts**

Press STOP while the alarm sound is heard. You can stop even when the HOLD function is activated.
Playing Back a Message at a Desired Time with an Alarm (Continued)

Notes
• If the alarm time comes while another message is being played back with an alarm, the playback stops and the new message will be played back.
• If the alarm time comes during recording, the alarm will sound after the recording is finished. “(●)” will flash when the alarm time comes.
• If more than one alarm time comes during recording, only the first message will be played back.
• When the alarm time comes when the unit is in the menu mode, alarm will sound and the menu mode will be cancelled.
• If you erase the message you set the alarm for, the alarm setting will be cancelled.
• If you add an index to the message you set the alarm for, alarm setting remains on only the first part of the divided message.
• If you erase the index on the message you set the alarm for, the alarm setting will be cancelled.
• You can adjust the playback volume with the VOL control.
• If the alarm time comes during erasing, the alarm will sound after the erasing is finished.
• Alarm setting will not be cancelled when the alarm playback finishes. To cancel alarm setting, see below.

To check the alarm setting
Follow steps 1 and 2 on page 30 after selecting the alarm setting. The alarm date and time will be displayed in the display window.

To cancel the alarm setting or change the alarm time
①Select the message you set the alarm for, and press MENU button.
②Select “ALARM” and press the jog lever.
③To cancel the alarm setting: Press the jog lever up or down to select “OFF” and press the jog lever.
   To change the alarm date and time: Press the jog lever.
   When the alarm date is displayed, follow steps 3 to 5 on pages 30 and 31 to change the alarm date and time.
④Press MENU button.
   Exit the menu mode.
Preventing Accidental Operation — HOLD function

Slide the HOLD lever in the direction of the arrow. “HOLD” will flash three times, indicating that all the functions of the buttons are locked.

To cancel the HOLD function, simply slide the HOLD lever in the opposite direction.

Note
When the HOLD function is activated during recording, you must cancel the HOLD function before you can stop recording.

Tip
Even if the HOLD function is activated, you can stop the alarm playback. To stop the alarm or playback, press STOP.
Selecting the Display Mode

You can select the display mode for stop, recording and playback modes. Each time you press DISPLAY button, the display mode will change as shown below.

1 **Counter**
   Elapsed playback/recording time of one message.

2 **Remaining time**
   In the playback mode: The remaining time indication of the message.
   In the stop and recording mode: The remaining recording time indication.

3 **Recorded date**
   The date the current message was recorded.
   If the clock has not been set, “----Y--M--D” will be displayed.

4 **Press DISPLAY button**
   **Recorded date and time**
   The date and time the current message was recorded.
   If the clock has not been set, “--M--D--:--” will be displayed.
   Only the starting time of the recorded message is displayed. The displayed time does not advance during the recording.

5 **Press DISPLAY button**
   **Message name**
   The message name will be displayed in the display window.
   If the message has no name, the message name will not be displayed in the display window.

6 **Press DISPLAY button**
   **Longer message names**
   A message name with more than 10 characters will be displayed with the scroll function.

7 **Press DISPLAY button**
   **Sleep display mode**
   If the unit is left unoperated for more than 3 seconds in the stop mode, the display will turn to sleep display mode as shown below, regardless of the display mode setting.

8 **Press DISPLAY button**
   **To display the current time**
   Press STOP button during the sleep display mode. The current time will be displayed for 3 seconds in the display window.
Formatting a “Memory Stick”

You can format a “Memory Stick” using the Memory Stick IC Recorder. Formatting will delete all data recorded in the “Memory Stick” including images and other data. Before formatting, check the data in the “Memory Stick”.

Because a commercially available “Memory Stick” has already been formatted at the factory, you do not need to format a “Memory Stick” before the first use.

The supplied “Memory Stick” has also already been formatted.

1. Press MENU button.
   The menu mode will be displayed in the display window.

2. Press the jog lever up or down to select “FORMAT”.

3. Press the jog lever.

4. Press the jog lever up or down to select “YES”.

5. Press the jog lever. "OK?” will be displayed on the display.

6. Press the jog lever again.
   Formatting starts.
   "FORMATTING” will be displayed on the display.

After formatting, the display in step 2 will appear in the display window.

7. Press MENU button.
   Exit to the menu mode.

After formatting, three folders are automatically made in the “Memory Stick” (This is the same after inserting a “Memory Stick” for the first time.)

To cancel formatting
Select “NO” in the step 4 or press STOP button while “OK ?” is displayed in step 5.

Note
You cannot format when the write-protect switch on the “Memory Stick” is set to LOCK.
Changing IC Recorder Settings

Selecting the Recording Mode (MODE)

SP: You can record with better sound.

LP: You can record for longer time.

You can record messages for up to 63 minutes (SP mode) or 131 minutes (LP mode) using the supplied "Memory Stick" (16MB). In the case of other capacity types, see page 5.

1 Press MENU button.
The menu mode will be displayed in the display window.

2 Press the jog lever up or down to select “MODE”.

3 Press the jog lever.
The mode setting will be displayed in the display window.

4 Press the jog lever up or down to select “SP” or “LP” and press the jog lever.
The setting is completed.

5 Press MENU button.
Enter the menu mode.

Turning off the Beep Sound (BEEP)

ON: A beep will sound to indicate that an operation has been accepted.

OFF: No beep sound will be heard except for the alarm.

1 Press MENU button
The menu mode will be displayed in the display window.

2 Press the jog lever up or down to select “BEEP”.

3 Press the jog lever.
The beep setting will be displayed in the display window.

4 Press the jog lever up or down to select “ON” or “OFF” and press the jog lever.
The setting is completed.

5 Press MENU button.
Enter the menu mode.
Playing Back All Messages in a Folder Continuously (CONT.)

ON: You can play back all messages in a folder continuously.
OFF: Playback stops at the end of each message.

1 Press MENU button.
The menu mode will be displayed in the display window.

2 Press the jog lever up or down to display “CONT.”.

3 Press the jog lever.
The continuous playback setting will be displayed in the display window.

4 Press the jog lever up or down to select “ON” or “OFF” and press the jog lever.
The setting is completed.

5 Press MENU button.
Exit the menu mode.

Recording with an External Microphone or Other Equipment

1 Connect a plug-in-power type microphone or other equipment to the MIC (PLUG IN POWER) jack.

When recording with an external microphone

When you connect an external microphone, the built-in microphone is automatically cut off. When a plug in power type microphone is connected, power is automatically supplied to the microphone from the IC recorder.

When recording from other equipment

2 Follow the steps in “Recording Messages” on page 12 to record messages.

Notes
- Make sure that the plugs are connected securely.
- We recommend you make a trial recording to check the connections and volume control.
- When connecting equipment other than Sony’s, refer to the instruction manual of the equipment.
Before Using the Software

What you can do with the “Memory Stick Voice Editor“ Software

“Memory Stick Voice Editor“ software allows you to transfer the messages to your display monitor, to save them on your computer’s hard disk, and to play back and edit them.

Transferring the messages recorded on the Memory Stick IC recorder to your display monitor (page 48)

By removing the “Memory Stick“ from the IC recorder and connecting it to your computer, you can display the list of messages contained in the “Memory Stick“ on your computer’s screen.

Messages transferred to your computer can be played back on the computer. And you can edit (for example, labeling and changing the order of messages) these messages using the software on the computer. After editing them, you can transfer them back to the IC Recorder again.

Saving the messages on your computer’s hard disk (page 48)

You can save the messages in the “Memory Stick“ on your computer’s hard disk. You can save them as the following file types.

• MSV (Memory Stick Voice) file
• ICS (Sony IC Recorder) file
• WAV file (8-/16-bit)

Transferring messages back to the “Memory Stick“ for playing back with the IC recorder (page 52)

The messages saved in your computer or sound files (MSV, ICS, or WAV files) received with an e-mail message can be added to the “Memory Stick“ as MSV files, which can be played back on the IC recorder. You can add the messages one by one or all the messages in a folder at one time to the “Memory Stick“.

When you save all the messages in all the folders of your “Memory Stick“ onto your computer and write them back to the “Memory Stick“, you can restore the alarm, priority and other original settings on the IC recorder.
**File type**
The following file types only can be converted to the MSV file type and vice versa
- ICS (Sony IC Recorder) files, recorded as SP mode using IC Recorder ICD-R100
- PCM 8/11 kHz, 8-bit/16-bit monaural WAV files
For more information, see page 50.

**About file size**
When a message is saved in a different file type, the file size of a message differs as follows:
- Approximate file size of a one-minute message recorded in SP mode
  - MSV file: approx. 243KB
  - ICS file: approx. 248 KB
  - 8-bit WAV file: approx. 660 KB
  - 16-bit WAV file: approx. 1,320 KB
  (KB: kilobytes)
- Approximate file size of a 60-minute message recorded in SP mode
  - MSV file: approx. 14.1MB
  - ICS file: approx. 14.6 MB
  - 8-bit WAV file: approx. 37.8 MB
  - 16-bit WAV file: approx. 75.7 MB
  (MB: megabytes)
- Approximate file size of a 120-minute message recorded in LP mode
  - MSV file: approx. 13.7 MB
  - ICS file: cannot be converted.
  - 8-bit WAV file: approx. 55 MB
  - 16-bit WAV file: approx. 109 MB
  (MB: megabytes)
Installing the Software

System Requirements
Your computer and system software must meet the following minimum requirements.

- IBM PC/AT or compatible (You cannot use this software with Macintosh)
  - CPU: 200MHz Pentium® processor or higher
  - RAM: 32MB or more (64 MB or more recommended)
  - Hard disk space: 70MB or more depending on the size and number of sound files you store.
  - CD-ROM drive
  - Sound board: Sound Blaster 16 compatible
  - Display: High color (16 bit) or more and 800 x 480 dots or more
- OS: Microsoft Windows 98 or Windows 95 (You cannot use this software with Windows NT)

Note
You need a computer with a “Memory Stick” slot or optional “Memory Stick” adaptors as shown below to use this software.
- PC Card Adaptor for Memory Stick (MSAC-PC1, MSAC-PC2)
- PC card/Parallel Port Adaptor (MSAC-PR1) and PC Card Adaptor for Memory Stick (MSAC-PC1, MSAC-PC2)
- Floppy Disk Adaptor for Memory Stick (MSAC-FD1)
Depending on the adaptors, more system requirements may be needed.

To install the software
Install “Memory Stick Voice Editor” Software in your computer’s hard disk, etc.

Note
After installing, the following modules are also installed depending on the operation system of your computer.
- Microsoft DirectX MediaRuntime
- Microsoft DCOM95 for Windows95
These modules are not deleted after uninstalling the software.

1 Turn on your computer and start up Windows.

Note
Be sure to close all running programs before installing the “Memory Stick Voice Editor” Software.

2 Insert the supplied CD-ROM into the CD-ROM drive.
After inserting, the installer starts up automatically and the following window appears.
If the installer does not start up, double click [setup.exe] in the [Disk1] folder.

3 ① Click [Next].
The [Choose Destination Location] dialog box appears.
② Select the directory where the “Memory Stick Voice Editor” Software is to be installed and click [Next].
If you want to select the default directory, just click [Next].
The [Select Program folder] dialog box appears.
③ Click [Next].
The [About This System] dialog box appears.
④ Click [Next].
The installation of the software starts.

When the installation is finished, the following window appears.

4 Click [OK].
The computer restarts. After the restart, the installation is completed.
Connecting the “Memory Stick“ to Your Computer

To connect a “Memory Stick“ to your computer

To read the messages saved in the “Memory Stick“ from your computer, remove the “Memory Stick“ from the IC recorder and connect it to your computer by using either of the following methods:

If your computer has a Memory Stick slot
Insert the “Memory Stick“ directly into the slot.

If your computer does not have a Memory Stick slot
Use either of the adaptors below to connect the “Memory Stick“ to your computer. In either case, you need to install the driver for the adaptor. For details, refer to the instruction manual of the adaptor you use.

Using the Sony PC Card Adaptor MSAC-PC1 or MSAC-PC2
Insert the “Memory Stick“ into the PC Card Adaptor. Then insert the PC Card Adaptor into the PC card slot of your computer.

Note
When using the PC Card Adaptor, make sure to release the LOCK switch of the “Memory Stick“.

To uninstall the software
When you wish to uninstall the software, follow the steps below.

1 Click [Start] and select [Programs], [Memory Stick Voice Editor] and then [Uninstall].
The uninstaller starts up.

2 Follow the displayed instructions.

Note
If you wish to move the software to another drive or directory after it is installed, you need to uninstall the software and then reinstall it. The software does not work properly if you just move the files.

Tip
You can also start up the uninstaller by clicking [Start] and then selecting [Settings], [Control Panel], and [Add/Remove Programs].
Connecting a “Memory Stick” to your computer (continued)

Using the Sony Floppy Disk Adaptor MSAC-FD1

Insert the “Memory Stick” into the Floppy Disk Adaptor. Then insert the Floppy Disk Adaptor into the floppy disk drive of your computer.

Note

Depending on your computer’s environment, the playback sound may skip when you play back a message directly from the “Memory Stick” without saving it on your computer’s hard disk.

Using the Sony PC Card/Parallel Port Adaptor MSAC-PR1 and the Sony PC Card Adaptor MSAC-PC1 or MSAC-PC2

Connect the PC Card/Parallel Port Adaptor to the printer port of your computer. Insert the “Memory Stick” into the PC Card Adaptor. Then insert the PC Card Adaptor into the PC card slot of the PC Card/Parallel Port Adaptor.

Note

When using the PC Card Adaptor, make sure to release the LOCK switch of the “Memory Stick”.

About folder structures

The “Memory Stick” contains the following folder structures with the VOICE folder as the root folder.

VOICE folder

This folder controls messages when using the IC Recorder or the software. In this folder, message folders that is the same as “FOLDER” displayed in the display window of the IC Recorder are saved. As the initial settings, three message folders named “FOLDER01”, “FOLDER02”, and “FOLDER03” and the message list files (Msglist.msf and backup Msglistb.msf) are created in the VOICE folder after inserting a “Memory Stick” into the Memory Stick IC Recorder.

Message list file (Msglist.msf)

The message list file (Msglist.msf) describes and controls the VOICE folder structure, message and folder names, the number of messages contained in each message folder, the priority and alarm settings, and other file and folder information. A backup file (Msglistb.msf) is also saved.

Note

- Folder structures of a “Memory Stick” can be shown like this using Windows Explorer, but never edit, move, copy, or delete messages in Explorer’s window.
- Folder and files names indicated in Windows Explorer are different from the actual folder and message names (page 27).
Starting Up the Software

Starting up “Memory Stick Voice Editor”

1. Turn on your computer and start Windows.

2. Remove the “Memory Stick” from your IC recorder and connect it to your computer (page 41).

3. Click [Start], and select [Programs], [Memory Stick Voice Editor] and then [Memory Stick Voice Editor]. The “Memory Stick Voice Editor” starts up. The splash window appears, and after loading the message list file the following main window is displayed.

Note

If the setting of the display of Windows is set to “Large Font”, the main window appears different from the above one. It is recommended to set “Small Font” in the setting of the display. To change the setting, refer to the instruction manual of Microsoft Windows 95 or Windows 98.

The first time you start the software or when a “Memory Stick” drive is not found

After the splash window, the following dialog box for specifying the “Memory Stick” drive is displayed.

Select the “Memory Stick” drive from the drop-down list and click [OK]. The message folders of the selected drive’s VOICE folder are displayed in the folder list box.

Notes

- The drive letter for the “Memory Stick” differs depending on your computer’s settings or environment.
- If you select [Cancel] in the [Select Drive] dialog box, only the player section becomes active.
- If a new “Memory Stick” is inserted in the specified drive or you specify the drive without the VOICE folder, the dialog box stating “No Message Folder exists in Drive “XX.” Would you like to create new Message Folder?” is displayed. Click [Yes] to make the initial setting of the “Memory Stick” and display the main window. Click [Cancel] to display the [Select Drive] dialog box.

Notes

- Before starting the “Memory Stick Voice Editor”, make sure to insert the “Memory Stick” into your computer. When you insert it after the “Memory Stick Voice Editor” is started, the “Memory Stick” drive cannot be recognized.
- Before removing the “Memory Stick” from your computer, make sure to exit the “Memory Stick Voice Editor”. Otherwise, data may be damaged.

To quit the “Memory Stick Voice Editor”

Click the close button in the right corner of the window or [Exit] from the [File] menu.

Continued
Starting Up the Software (continued)

Names and Functions of the Main Window

1. **Menu commands/Toolbar**

You can access and execute the menu commands. The toolbar contains the buttons for common menu command tasks, providing quick way to do tasks. See page 57 for details.

2. **Drive box**

Select the desired drive from the drop-down list. Message folders in the VOICE folder in the selected drive are shown in the folder list box.

3. **Folder list box**

Message folders in the VOICE folder in the drive selected in the drive box are shown in this box. Click the desired folder from the list. Messages in the selected folder are shown in the message list box.
4 Message list box

<table>
<thead>
<tr>
<th>No.</th>
<th>Message Name</th>
<th>Length</th>
<th>Rec Date/Time</th>
<th>Priority</th>
<th>Alarm</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>memo1</td>
<td>00h 08m 51s</td>
<td>1999/09/18</td>
<td>**</td>
<td></td>
<td>SP</td>
</tr>
<tr>
<td>002</td>
<td>memo2</td>
<td>00h 09m 25s</td>
<td>1999/09/18</td>
<td>**</td>
<td></td>
<td>SP</td>
</tr>
<tr>
<td>003</td>
<td>Action plan</td>
<td>00h 14m 19s</td>
<td>1998/04/26</td>
<td>**</td>
<td></td>
<td>SP</td>
</tr>
<tr>
<td>004</td>
<td>Agenda</td>
<td>00h 10m 11s</td>
<td>1998/04/26</td>
<td>**</td>
<td></td>
<td>SP</td>
</tr>
<tr>
<td>005</td>
<td>Message1</td>
<td>00h 04m 40s</td>
<td>1999/03/10</td>
<td>**</td>
<td></td>
<td>SP</td>
</tr>
<tr>
<td>006</td>
<td>Message2</td>
<td>00h 04m 35s</td>
<td>1999/03/10</td>
<td>**</td>
<td></td>
<td>SP</td>
</tr>
<tr>
<td>007</td>
<td>I don’t forget</td>
<td>00h 04m 26s</td>
<td>1999/03/18</td>
<td>Daily 1-20</td>
<td></td>
<td>SP</td>
</tr>
</tbody>
</table>

The messages in the selected folder are displayed with the relevant information: message number, message length, recorded date and time, priority and alarm settings, and recording mode (SP or LP).

5 Player Section

This section controls playback operations. The information of the “Memory Stick” and the message being played back is displayed. It also contains the buttons for playback operations. When you double-click an MSV file on the desktop without starting the Memory Stick Voice Editor, only the player section is displayed.

Note

The remaining time displayed on the IC Recorder may be shorter than that displayed in the “Memory Stick Voice Editor” software. The unit requires a certain amount of time for system operation. That time is subtracted from the remaining time, which is the reason for the difference.
Playing Back Messages on the Computer

You can play back the messages (MSV files only) saved both in the “Memory Stick” and your computer’s hard disk on the player section window. The playback sound is heard from the computer’s speakers.

To play back messages in the “Memory Stick”

1. Click the folder where you want to play back a message from the folder list box.

2. Double click the desired message from the message list box.

Playback of the message starts.

To play back MSV files saved in the hard disk of the computer

1. Open an MSV file from the computer’s hard disk on the “Memory Stick Voice Editor” with either of the following methods:
   - Double-click the MSV file on your computer’s desktop.
   - Click on the toolbar or select [Open MSV file] from the [File] menu.

   The [Open] dialog box is displayed. Select an MSV file and click [Open].

2. Click (play) button in the player section (page 45) to start playback.

Note
When you double-click on an MSV file without starting the “Memory Stick Voice Editor“, only the player section (page 45) is displayed and the playback of the message starts. To display the folder and message list boxes in the main window, exit the player section and then start the “Memory Stick Voice Editor”.

Tip
You can also play back the message by clicking (play) button in the player section of the main window after clicking the desired message from the message list box.
Various ways of playback

You can play back in various ways by using the buttons on the player section.

Functions of playback control buttons

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
</table>
| – | Pause playback  
To resume playback, click the button again. |
| ■ | Stop playback |
| ▸ | Go back to the beginning of the current message. |
| ◾ | Skip to the next message. |
| ▷ | Search backward during playback (Review).  
To resume normal play, click the button again. |
| ◺ | Search forward during playback (Cue).  
To resume normal play, click the button again. |
| × | Turn the volume off temporarily.  
To turn on the sound, click the button again. |
| VOL + or – | Adjust the volume.  
To increase the volume, click +.  
To decrease the volume, click –.  
Click VOL to adjust the volume with the slider. |

To play back a message repeatedly

You can play back a message repeatedly.

1. Select the message you want to play back.
2. Click 
   (repeat) button.  
The Repeat Play mode is selected.  
To resume normal playback, press 
again.
3. Click 
   (play) button.  
The message is played back repeatedly.  
To stop playback, click 
(stop) button.

Continued
Saving Messages to the Computer

Saving messages or folders

You can save the messages of the “Memory Stick” onto your computer’s hard disk as the following file types.

- MSV (Memory Stick Voice) files
- ICS (Sony IC Recorder) files
- 8-bit/16-bit WAV files

See page 50 for details on file types.

If you want to save as MSV files, select message(s) or folder(s) in the main window, and drag and drop into the certain place in the hard disk drive. The file or folder names will be labeled automatically.

To save as another files, see “Saving as other file types” on the next page.

You can also save entire VOICE folder in a “Memory Stick” with information about alarm setting, priority marks, etc. in the hard disk (see page 50).
Saving as other file types

When saving a message file onto your computer’s hard disk, you can specify a file type: ICS file or 8-bit/16-bit WAV file as well as an MSV file. Without specifying, message files are saved in MSV files as they are saved in the “Memory Stick” window. Please note that you can edit and play back MSV files only on the “Memory Stick Voice Editor” software.

To save by dragging and dropping with the right mouse button

You can drag and drop the message(s) or folder(s) with the right mouse button and select the file type from the shortcut menu displayed.

1. Use the right mouse button to drag the message file(s) or message folder(s) from the “Memory Stick Voice Editor” window and drop it/them onto a window or folder of the Explorer or desktop of your computer.
   When you drop it/them onto the destination folder, a shortcut menu listing the available file types is displayed.

   - **Save as MSV file**
   - **Save as WAV (8-bit) file**
   - **Save as WAV (16-bit) file**
   - **Save as ICS file**
   - **Cancel**

2. Click the desired file type.
   The dropped message file(s) or all the message files contained in the dropped folder are saved in the destination folder in the specified file type.

To save by selecting the file type in the [Save] dialog box

You can select the file type in [Save] dialog box to save a message file or message folder onto your computer’s hard disk.

1. From the “Memory Stick Voice Editor” window, click the desired message file or folder.

2. Do one of the following:
   - Click (Save Message file) or (Save Folder) on the toolbar.
   - Click [Save Message File] or [Folder], [Save Folder] from the [File] menu.
   - Click on the selected message or folder with the right mouse button and select [Save Message File] or [Save Folder] from the shortcut menu.
   The [Save File] or [Save Folder] dialog box is displayed.

3. Specify the destination folder, file name (folder name), and file type and click [Save].

Continued
About file types

You can handle the following file types on the “Memory Stick Voice Editor”. Among them, only the MSV files can be played back and edited on the “Memory Stick Voice Editor”.

**MSV file (Memory Stick Voice file, extension.msv)**

The MSV file is a sound file format used in recording messages on the Memory Stick IC recorder. The sound data is compressed so that the size of the data is relatively small. You can edit and play back the MSV files on the “Memory Stick Voice Editor”, write them on the “Memory Stick” to be restored and played back on the IC recorder.

An MSV file can be converted into an ICS or WAV file on the “Memory Stick Voice Editor” and saved in the computer’s hard disk. (You cannot convert an MSV file in the LP mode into an ICS file.)

**ICS file (SONY IC RECORDER file, extension.ics)**

The ICS file is Sony’s original sound file format used in recording messages on the IC recorder ICD-R100. The sound data is compressed so that the size of the data is relatively small. The ICS files can be played back on the “ICS-Player” software. By restoring the ICS files back to the IC recorder, you can also play back the files on the IC recorder ICD-R100.

You can use the Memory Stick Voice Editor to convert an ICS file recorded in the SP mode into an MSV file. (You cannot convert an ICS file recorded in the LP or SP&LP mode into an MSV file.)

---

**Saving Messages to the Computer (continued)**

**Saving the entire VOICE folder at one time**

You can save all the messages in the VOICE folder of the “Memory Stick” onto your computer’s hard disk at one time by specifying the file type. When you save the messages as MSV files, you can restore the messages as they are with the alarm, priority or other settings onto the IC recorder later on (Page 52).

1. Select the “Memory Stick” drive in the drive box. The message folders in the selected “Memory Stick” are displayed in the message folder list box.

2. Click (Save as VOICE Folder) on the toolbar or select [Save as VOICE Folder] from the [File] menu.

3. Specify the destination to which the VOICE folder is to be saved in the [Save in] box and the file type to save the contained message files in the [Save as type] box.

   To restore the messages as they are onto the IC recorder later on, save messages as MSV files.

4. Click [Save].

   All the message folders and their component message files contained in the VOICE folder are saved as the specified folder name and file type. The folder and file names within the VOICE folder are automatically named. When saved as MSV files, the message list files are also saved.
8-bit/16-bit WAV file (WAV FILE
[8 bit/16-bit] file, extension. wav)

The 8-bit or 16-bit WAV file is a PCM 8/11kHz, 8/16-bit monaural sound file used in recorded sound in standard Windows application software. You can play back the WAV file on Windows software such as the “Sound Recorder” supplied with Windows 98 or Windows 95. To use the application compatible with a 16-bit WAV file, save the message as a WAV (16-bit) file.

You can convert a WAV file into an MSV file on the Memory Stick Voice Editor. (Only the PCM 8/11kHz, 8/16-bit monaural WAV file can be converted. A 11kHz WAV file is converted into an SP mode MSV file, while an 8kHz WAV file is converted into an LP mode MSV file.)
Adding or Replacing Messages to the "Memory Stick"

Adding messages or folders

You can add the selected message(s) in your computer’s hard disk to the “Memory Stick” as MSV files. An MSV file is added as it is and ICS (SP mode only) and WAV (8/16 bit, linear PCM monaural) files are automatically converted into MSV files. The message list file data is also updated to reflect the change.

The added message can be played back on the IC recorder.

In the window or folder of the Explorer or your computer’s desktop, click the desired message file(s) or folder(s) you want to add to the “Memory Stick”, and then drag and drop onto the desired position in the “Memory Stick Voice Editor”.

Notes

- When a message or folder is added one by one, not by entire VOICE folder (page 50), its alarm and priority settings are cancelled.
- If you drop the message file or folder in a message folder in the folder list box, the message(s) will be added to the end of the selected folder.

Tip

You can add the selected message(s) by clicking [Add/Replace Messages] in the [File] menu and then [Add Message File] or [Add Folder/Replace VOICE Folder], or just clicking or in the toolbar.

In this case, the message(s) will be added to the end of the currently open folder of the “Memory Stick”.

Restoring the VOICE Folder Back to the “Memory Stick” (Replacing)

When you have saved all the message files at one time in the VOICE folder of the “Memory Stick” onto your computer’s hard disk as MSV files (page 50), you can restore the VOICE folder back to the “Memory Stick” as it is. The messages can be played back on your IC recorder. All the alarm and priority settings are also maintained.

The existing VOICE folder in the “Memory Stick” will be replaced.

1 In the window or folder of the Explorer or your computer’s desktop, click the desired VOICE folder you want to overwrite onto the "Memory Stick".

2 Drag and drop the VOICE folder onto the folder or message list box on the “Memory Stick Voice Editor”.

The [Replace VOICE Folder] window is displayed.

3 Click [Yes] to replace the VOICE folder.

To stop replacement, click [No]. When you select [Yes], the dialog box appears asking if you want to backup the VOICE folder currently saved in the "Memory Stick".
4 Click [Yes] to backup the VOICE folder.
When the backup is not necessary, click [No]. When you select [Yes], the message files currently contained in the “Memory Stick” are saved in the computer’s hard disk as a VOICE folder. Then all the messages are deleted from the “Memory Stick” and the new VOICE folder is saved. The message list file is updated to reflect the change.

Tip
You can replace by clicking [Add/Replace Messages] in the [File] menu and then [Add Folder/Replace VOICE Folder], or just clicking in the toolbar.
Editing Messages in the “Memory Stick“ on the Computer Screen

You can edit the message files (MSV files only) or message folders contained in the “Memory Stick” excluding adding/deleting an index.

Changing the message or folder name

Changing the message name

Click the message on the message list box and click [Rename Message] from the [File] menu.
In the message name box, you can input a new title of up to 254 characters.

Changing the folder name

Click the message folder on the folder list box and click [Folder], [Rename Folder] from the [File] menu.
In the folder name box, you can input a new name of up to 44 characters.

Notes

• The message and folder names you input are for the display in the “Memory Stick Voice Editor” and the IC recorder, which is controlled independently by the message list file. The change in the names does not reflect the folder or file names displayed in the Windows Explorer.
• When you input a character that the IC recorder cannot display, a different character may appear on the display window of the IC recorder.

Moving a message or a folder

You can move a message within the folder to change its order, or move it to another folder. You can also move a message folder within the VOICE folder.
Drag and drop a message or a folder you want to move onto the destination.

Deleting a message or a folder

You can delete a message or a folder.
Select a message or a folder, and then click ☒ on the toolbar or click on the selected message or folder with the right mouse button and select [Delete Message] or [Delete Folder] from the shortcut menu.

Creating a folder

You can create a new message folder in the VOICE folder.
Click ☐ on the toolbar or click [Folder], [New Folder] from the [File] menu.
Sorting the messages
By clicking each button on the message list box, you can rearrange the order of the messages. When the messages in the list box are sorted, they are renumbered, thus sorting the messages in the “Memory Stick” and updating the message list file. If you sorted messages using the software, you can play back messages by the IC Recorder in the order sorted using the software.

Changing the alarm settings
You can change the alarm setting of the message on the “Memory Stick Voice Editor”.

1. Click the message whose alarm setting you want to change on the message list box and click [Set/ Cancel Alarm] from the [File] menu. The following window appears.

2. In the [Alarm Setting] group box, set the day for alarm playback.

3. In the [Alarm Time] group box, set the time for alarm playback.

4. In the [Alarm Playback Mode] group box, choose what to play back at the alarm time.

5. Click [OK]. The alarm setting is saved. The alarm setting displayed in the [Alarm] column on the message list box reflects the change.

To cancel the alarm setting
Click [Alarm Off] in the window on the step 1. The alarm setting is cancelled.

Note
The message will not be played back on the “Memory Stick Voice Editor” at the alarm time. Restore the message back to the IC recorder via the “Memory Stick”.

Continued
Changing the priority settings

You can add priority mark(s) to an important message.

1. Click the message for which you want to add priority marks on the message list box with the right mouse button and select [Set Priority] from the shortcut menu. The menu to select the priority marks is displayed.

2. Click the desired priority mark(s) or press the arrow key to select the desired mark(s) and press the Enter key to fix. The priority setting is saved. The priority setting displayed in the [Priority] column on the message list box reflects the change.

 Hint
- If you change the priority mark settings using the software, you can play back messages by the IC Recorder in the order changed using the software.
- You can sort the messages according to the number of priority marks. They are displayed in the same order when restored on the IC recorder.
## Using the Menu Commands

### File menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open MSV File</strong></td>
<td>Opens an MSV file in the computer’s hard disk onto the player section of the “Memory Stick Voice Editor”.</td>
</tr>
<tr>
<td><strong>Rename Message</strong></td>
<td>Changes the name of the selected message.</td>
</tr>
<tr>
<td><strong>Save Message File</strong></td>
<td>Saves the selected message by specifying the file type, file name, and destination folder.</td>
</tr>
<tr>
<td><strong>Play Back</strong></td>
<td>Plays back the message selected in the message list box. If no message is selected, the message opened on the player section will be played back.</td>
</tr>
<tr>
<td><strong>Set Priority</strong></td>
<td>Opens the dialog box to set the priority marks for the selected message.</td>
</tr>
<tr>
<td><strong>Set/Cancel Alarm</strong></td>
<td>Opens the dialog box to set the alarm playback for the selected message.</td>
</tr>
<tr>
<td><strong>Delete Message</strong></td>
<td>Deletes the selected message.</td>
</tr>
<tr>
<td><strong>Folder</strong></td>
<td></td>
</tr>
<tr>
<td>• <strong>Rename Folder</strong></td>
<td>Changes the name of the selected message folder.</td>
</tr>
<tr>
<td>• <strong>Save Folder</strong></td>
<td>Saves the messages in the selected folder by specifying the file type, folder name, and destination folder.</td>
</tr>
<tr>
<td>• <strong>New Folder</strong></td>
<td>Creates and adds a new folder in the folder list box.</td>
</tr>
<tr>
<td>• <strong>Delete Folder</strong></td>
<td>Deletes the selected folder.</td>
</tr>
<tr>
<td><strong>Save as VOICE Folder</strong></td>
<td>Saves all the message files of all the message folders in the VOICE folder at one time onto the computer’s hard disk.</td>
</tr>
</tbody>
</table>

### Add/Replace Messages

- **Add Message File**
  Add a message file from the computer’s hard disk to the “Memory Stick” as MSV files. An MSV file is added as it is and ICS (SP mode only) and WAV (8/16 bit, linear PCM monaural) files are automatically converted into MSV files.

- **Add Folder/Replace VOICE Folder**
  Adds all the messages in the selected message folder from the computer’s hard disk to the “Memory Stick”. When you select a VOICE folder in the hard disk, the folder replaces the existing VOICE folder in the “Memory Stick” after saving its backup.

- **Select Drive**
  Changes the drive in the drive box.

- **Exit**
  Exits the “Memory Stick Voice Editor”.

---

Continued
Using the Menu Commands (continued)

Edit menu

Undo
Cancels the last command.

Redo
Cancels the action of the [Undo] command.

Sort Messages
• Reversely
  Arranges the messages in reverse.

• by Name
  Arranges the messages in alphabetical order of the message names. Click again to sort the messages in reverse.

• by Recorded Date
  Arranges the messages from the oldest to the most recent recorded date. Click again to sort the messages in reverse.

• by Length
  Arranges the messages from the shortest recording to the longest. Click again to list the messages in reverse.

• by Priority
  Arranges the messages from the largest number to the smallest number of the priority marks. Click again to sort the messages in reverse.

Select All
Selects all the messages in the message list box or all the folders in the folder list box (whichever box you place the cursor on).

View menu

Toolbar
Click to place a check mark for showing the toolbar. Click again to remove the check mark and hide the toolbar.

Refresh
Updates the display of the messages and folder list boxes to reflect any changes. (When you change messages or folders on the Windows Explorer, use this command to reflect the change.)

Help menu

Help Topics
Displays the help topics of the “Memory Stick Voice Editor”.

About Memory Stick Voice Editor
Displays the version number of the “Memory Stick Voice Editor”.

**Toolbar**

- **Open MSV File**
  Opens an MSV file in the computer’s hard disk onto the player section of the Memory Stick Voice Editor.

- **New Folder**
  Creates and add a new folder in the folder list box.

- **Save as VOICE Folder**
  Saves all the message files of all the message folders in the VOICE folder at one time onto the computer’s hard disk.

- **Save Folder**
  Saves the messages in the selected folder by specifying the file type, file name, and destination folder.

- **Save Message File**
  Saves the selected message by specifying the file type, file name, and destination folder.

- **Delete**
  Deletes the selected message or folder.

- **Select Drive**
  Changes the drive in the drive box.

- **Add Folder/Replace VOICE Folder**
  Adds all the messages in the selected message folder from the computer’s hard disk to the “Memory Stick”. When you select a VOICE folder in the hard disk, the folder replaces the existing VOICE folder in the “Memory Stick” after saving its backup.

- **Add Message File**
  Add a message file from the computer’s hard disk to the “Memory Stick” as MSV files. An MSV file is added as it is and ICS (SP mode only) and WAV (8/16 bit, linear PCM monaural) files are automatically converted into MSV files.

- **Undo**
  Cancels the last command.

- **Redo**
  Cancels the action of the [Undo] command.

- **Help Topics**
  Displays the help topics of the Memory Stick Voice Editor.
Additional Information

Precautions

On power
Operate the unit only on 3 V DC. Use two size AAA (LR03) alkaline batteries.

On safety
Do not operate the unit while driving, cycling or operating any motorized vehicle.

On handling
- Do not leave the unit in a location near heat sources, or in a place subject to direct sunlight, excessive dust or mechanical shock.
- Should any solid object or liquid fall into the unit, remove the batteries and have the unit checked by qualified personnel before operating it any further.

On noise
- Noise may be heard when the unit is placed near an AC power source, a fluorescent lamp or a mobile phone during recording or playback.
- Noise may be recorded when an object, such as your finger, etc., rubs or scratches the unit during recording.

On maintenance
To clean the exterior, use a soft cloth slightly moistened in water. Do not use alcohol, benzine or thinner.

On using a “Memory Stick”
- Do not touch or allow metallic objects to come into contact with the metal parts of the connecting section.
- Stick the label on the labeling position.
- Do not bend, drop or apply strong shock to the "Memory Stick".
- Do not disassemble or modify the "Memory Stick".
- Do not let the "Memory Stick" get wet.
- Do not use or keep the "Memory Stick" in locations that are:
  - Extremely hot such as in a car parked in the sun
  - Under direct sunlight
  - Very humid or subject to corrosive gases
- When you carry or store a "Memory Stick", put it in its case.

If you have any questions or problems concerning your unit, please consult your nearest Sony dealer.

Should a problem occur with the unit with the “Memory Stick” inserted, take it to your nearest Sony dealer without removing the “Memory Stick”. This will allow the problem to be resolved more quickly.

Data backup
After the repair, recorded data sometimes will be deleted. Back up important data regularly to avoid losing the data.
Additional Information

Troubleshooting

Before taking the unit for repair, check the following sections.
Should the problem persist after you have made these checks, consult your nearest Sony dealer.

IC Recorder

The unit does not operate.
• The batteries have been inserted incorrectly.
• The batteries are weak.
• The buttons are locked with the HOLD switch. (If you press a button, “HOLD” will flash three times.)

No sound comes from the speaker.
• The earphone or headphones are plugged in.
• The volume is turned down completely.

You cannot start recording.
• There is no “Memory Stick” inserted.
• The write-protect switch on the inserted “Memory Stick” is set to LOCK (page 11).
• The memory is full. Erase some of the messages. See page 17.

You cannot erase a message.
• The write-protect switch on the inserted “Memory Stick” is set to LOCK (page 11).
• The message or the folder which contains the message is set to “Read-only” in the computer. Open the data in a “Memory Stick” using Windows Explorer and remove the check for “Read-only” under “Properties”.
• You cannot erase other formatted (except MSV file format) data using the unit.

You cannot erase all messages in a folder.
• The write-protect switch on the inserted “Memory Stick” is set to LOCK (page 11).
• The folder or the message in the folder is set to “Read-only” in the computer. Open data in a “Memory Stick” using Windows Explorer and remove the check for “Read-only” under “Properties”.

You cannot overwrite.
The remaining memory is too short.
The overwritten part will be deleted after the overwriting part finishes recording. Therefore, you can only overwrite within the remaining recording time.

Noise is heard.
• An object, such as your finger, accidentally rubbed or scratched the unit during recording and that noise was recorded.
• The unit was placed near an AC power source, a fluorescent lamp or a mobile phone during recording or playback.
• The plug of the connected microphone was dirty when recording. Clean the plug.
• Earphone/headphones plug is dirty. Clean the plug.

Recording level is low.
The MIC SENS selector is set to “L”. Set it to “H” (see page 13).

Recording is interrupted.
The advanced VOR function (page 14) is activated. Set the VOR selector to OFF.

Recording level is unstable (when recording music, etc.)
This unit is designed to automatically adjust the recording level when recording meetings, etc., and is not suitable for music recording.

Playback speed is too fast or too slow.
Set the PLAY SPEED selector to “NORMAL.” See page 19.

“--M--D --:--” is displayed.
You have not set the time (see page 10).

“----Y--M--D” or “--M--D --:--” is displayed on the REC DATE display.
The date or time of recording will not be displayed if you recorded the message when the clock was not set.

There are fewer menu items in the menu mode.
There are some menu items which are not displayed because a “Memory Stick” is not inserted.

A character in a folder or message name is displayed as “□”.
The unit cannot support and display some characters which are entered using the supplied “Memory Stick Voice Editor” software.

Continued
Troubleshooting (Continued)

Messages are not sorted in order of the number of priority marks in a folder.
Unless you sort using the supplied “Memory Stick Voice Editor” software, messages are sorted in the unit the same as the setting in the computer. Sort again in the order of the number of priority marks in the computer using the supplied “Memory Stick Voice Editor” software.

The remaining time displayed in the display window is shorter than that displayed in the supplied “Memory Stick Voice Editor” software.
The unit requires a certain amount of time for system operation. That time is subtracted from the remaining time, which is the reason for the difference.

The unit does not operate correctly.
Take out the batteries and insert them again.

“Memory Stick Voice Editor” Software

“Memory Stick Voice Editor” software cannot be installed.
The memory space on the computer is too small. Allocate a larger memory space.

Messages recorded using the IC recorder cannot be transferred to the computer.
• The “Memory Stick” is not recognized. Quit the software and reinsert the “Memory Stick”, and then restart the software. The software can only recognize the “Memory Stick” inserted before the startup.
• Check that the “Memory Stick” adaptor is connected correctly. For more information, see the instruction manual of the adaptor.

Messages cannot be played back.
• No sound board is installed (page 40).
• No speaker is built-in or connected to the computer.

Playback sound is interrupted.
When you choose the floppy disk drive, playback sound is sometimes interrupted.

Saved ICS files cannot be played back.
The software does not support playback of ICS files. Install the ICS player or “ICD-PCLINK” software.

Saved WAV files cannot be played back.
The software does not support play back of WAV files. Install the software which supports playback of WAV files (for example, Microsoft Sound Recorder).

Playback sound volume is too low.
• Turn up the volume on the computer. (Refer to the instruction manual of the computer.)
• The volume of WAV files can be changed and saved using the “Increase Volume” feature of the Microsoft Sound Recorder.
Counter or slider moves incorrectly. There is noise.

This happens when you play back messages in the computer to which you added/deleted an index, overwrote, or added a recording. Save ICS files (WAV files when messages are recorded in the LP mode) in the hard disk first, and then add them to the “Memory Stick”. (If you do this operation, the recorded date and time of messages recorded in the LP mode will be deleted.)

Operation is slow when there are many messages.

Regardless of the length of the recording time, when the total number of messages is large the operation becomes slower.

Display does not work during saving, adding, or deleting of messages.

It takes more time to copy or delete long messages. After completing operations, the display works normally.

The Software ‘hangs’ when “Memory Stick Voice Editor” Software starts up.

- There may be conflict between the software and other driver or application.
- The message list file may be broken.
  Delete the message list file (Msglistb.msf) in the VOICE folder on the Explorer window, and then restart the software.
  If the problem persists, delete “Msglist.msf” file. If you delete “Msglist.msf” file, the information of messages (for example, order of folders, folder names, priority setting, alarm setting) will be deleted (except message names).
- Check if the write-protect switch of the “Memory Stick” is set to the “LOCK“ position when you use the PC card adaptor.
System Limitations

There are some system limitations of the unit. Troubles as mentioned below are not malfunctions of the unit.

You cannot record messages up to the maximum recording time.

- If you record messages in a mixture of SP and LP modes, the recordable time varies from the maximum SP mode recording time to the maximum LP recording time.
- There may be other formatted data (for example, images) in the inserted “Memory Stick”.
- Due to the minimum recording unit, if the length of each message cannot be divided by the minimum recording unit, the remaining recording time may decrease by more than the total length of the messages.
- The maximum recording time varies depending on the number of folders or messages.

You cannot add an index while recording/playing a message.

- Remaining memory of the inserted “Memory Stick” is too short to add. If the amount of remaining memory is shorter than that of the minimum recording unit, you cannot add an index.
- You cannot add an index in a folder which has over 999 messages.

You cannot erase the index.

You cannot erase an index to combine different recording mode (SP/LP) messages.

You cannot add a folder.

Remaining memory of the inserted “Memory Stick” is too short to add. If the amount of remaining memory is shorter than that of the minimum recording unit, you cannot add a folder.

About the minimum recording unit

For recording a message or adding an index or a folder, the time of the minimum recording unit is needed.

Although the actual recording time of a message may be less than that of the minimum recording unit, the time of the message is counted as a minimum recording unit.

If the remaining recording time of the inserted “Memory Stick” is less than that of the minimum recording unit, you cannot add an index or a folder in the “Memory Stick”.

The minimum recording unit

<table>
<thead>
<tr>
<th>Capacity of the “Memory Stick”</th>
<th>SP mode</th>
<th>LP mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 MB</td>
<td>2 seconds</td>
<td>4 seconds</td>
</tr>
<tr>
<td>8 MB</td>
<td>2 seconds</td>
<td>4 seconds</td>
</tr>
<tr>
<td>16 MB</td>
<td>4 seconds</td>
<td>8 seconds</td>
</tr>
<tr>
<td>32 MB</td>
<td>4 seconds</td>
<td>8 seconds</td>
</tr>
<tr>
<td>64 MB</td>
<td>4 seconds</td>
<td>8 seconds</td>
</tr>
</tbody>
</table>

About the maximum recording time and the maximum number of messages or folders

A “Memory Stick” saves not only recorded messages but also the information about indexes and the number of folders. Therefore, as the number of messages or folders increases, the amount of memory in the “Memory Stick” decreases.

The maximum recording time and the number of messages or folders varies depending on this.

However, only in the case that you recorded up to the maximum recording time, you can add up to two indexes. This means you can divide a message into three parts and delete the unnecessary part in the message that was recorded up to the maximum recording time.
Error Messages

IC Recorder

“MEMORY STICK ERROR”
Insert the “Memory Stick” again. After inserting, if this message is displayed again, the inserted “Memory Stick” may be out of order.

“NO MEMORY STICK”
Insert the “Memory Stick” again if already inserted.

“UNKNOWN DATA”
The unit cannot play or erase the selected message because the file type is different.

“ACCESS ERROR”
After checking the write-protect switch, insert the “Memory Stick” again. If this is displayed again, the inserted “Memory Stick” needs to be formatted (page 35). Back up the data in the computer after checking the contents.

“MEMORY STICK LOCKED”
The write-protect switch on the inserted Memory Stick is set to “LOCK” (page 11). You cannot record, edit or format in this condition. Slide the switch to the left and insert again.

“FILE PROTECT”
Messages have been set to “Read-only” in the computer. You cannot edit or erase messages and folders including these “Read-only” messages.
Remove the check for “Read-only” under “Properties” of files that are opened by Windows Explorer.

“FOLDER PROTECT”
Folders have been set to “Read-only” in the computer. You cannot edit, erase, add messages, or move messages in these “Read-only” folders.
Remove the check for “Read-only” under “Properties” of folders that are opened by Windows Explorer.

“LOW BATTERY”
Batteries are weak. Replace batteries with new ones.

“INDEX FULL”
Because there are over 999 messages in the folders or the remaining memory of the Memory Stick is short, it is impossible to add an index. Erase some messages before adding.

“FOLDER FULL”
Because the remaining memory of the “Memory Stick” is short, it is impossible to add a folder. Erase some folders or messages before adding.

“INDEX ERASE PROHIBITED”
You cannot erase an index to combine messages of different recording modes.

“FOLDER ERASE PROHIBITED”
You cannot delete the last folder left in a “Memory Stick”.

“ALREADY SET”
You set the alarm to play back a message at a date and time previously set on another message. Change the alarm date and time or the previously set date and time.

“BACK DATE”
You set the alarm when the time is already past. Check it and set the appropriate date and time again.

“NO MEMORY SPACE”
There is no space to record in the inserted “Memory Stick”. Erase recorded messages or insert another “Memory Stick”.
If there are other formatted data in the “Memory Stick”, delete them on the unit used to record them.

“NO MESSAGE”
There is no recorded message in the folder. You cannot make alarm setting, etc., because of this.

“PLEASE SET DATE & TIME”
If you do not set date and time, you cannot set the alarm. To set date and time, see page 10.

Continued
Error Messages (Continued)

“Memory Stick Voice Editor” Software

“No Message Folder exists in Drive ‘XX’. Would you like to create new Message Folder?”
To display and edit messages on the “Memory Stick Voice Editor” and the IC recorder, you need a VOICE folder and a message list file. Click [Yes] to create the message folder. If you click [No], the [Select Drive] dialog box will be displayed.

“Message has been modified. Updating the Message List File...”
The message data differs from those saved in the message list file. Click [OK] to update the message list file to reflect the change.

“Cannot delete the folder named “FOLDER01.” The folder contains files or folders that are not MSV format.”
You cannot delete a folder containing files of types other than MSV files. Move or delete the files of types other than MSV files on Windows Explorer.

“No disk space for creating temporary file. Cannot restore the original file.”
When you delete a message, it is copied temporarily onto a temporary file. If the disk space is limited in the TEMP area, you cannot restore the original file by selecting [Undo] from the [Edit] menu.

“No more space available on selected drive. (An additional ?? KB is needed.)”
There is not enough disk space available in the destination drive to save the messages. Secure sufficient space before trying to save the messages.

“The specified folder already exists. Please rename the folder.”
A folder with the same name exists in the destination folder.

“Cannot add message. No disk space available in message management area.”
Because of the system limitations in the “Memory Stick”, the message or folder cannot be added.

“Could not add these files because of incompatible file format.”
You are trying to add a file of a file type that the “Memory Stick Voice Editor” does not support.

“This drive is locked. Release the lock.”
The write-protect switch of the “Memory Stick” is set to “LOCK” (page 11). Set it to the write-enable position.

“Cannot move/add a message. The number of messages in the folder exceeds 999.”
You can only save up to 999 messages in a folder. Delete unnecessary messages or move them to another folder.

“Cannot change message name. This file is read-only.”
The message is a read-only file. Open the [Properties] window of the message on the Windows Explorer and remove the check for [Read-Only].
**Specifications**

**Recording media**
“Memory Stick”, Monaural recording

**Recording time**
- SP: 63 minutes
- LP: 131 minutes (using the supplied 16MB Memory Stick)

**Frequency response**
- SP: 240 Hz - 4,800 Hz
- LP: 240 Hz - 3,200 Hz

**Speaker**
approx. 36 mm (1 7/16 in.) dia.

**Power output**
200 mW

**Input/Output**
- Earphone jack (minijack) for 8 - 300 ohms earphone/ headphones
- Microphone jack (minijack, monaural)

**Playback speed control**
LP mode: FAST +30%, SLOW –15%
SP mode: FAST +20%, SLOW –15%

**Power requirements**
Two size AAA (LR03) alkaline batteries: 3 V DC

**Dimensions (w/h/d)**
44.2 x 108.9 x 17.5 mm (1 3/4 x 4 3/8 x 23/32 in.)

**Mass (incl. batteries and a “Memory Stick”)**
88 g (3.1 oz)

---

**Supplied accessories**
- “Memory Stick” (16MB, MSA-16A) x 1
- “Memory Stick Voice Editor” (CD-ROM) x 1
- Carrying case x 1
- Size AAA (LR03) alkaline battery x 2 (U.S.A. and tourist models only)

---

**Optional accessories**
- Electret Condenser Microphone ECM-T115
- Active speakers SRS-T1
- AC Power Adaptor AC-E30HG
- Memory Stick MSA-4A (4 MB), MSA-8A (8 MB), MSA-16A (16 MB), MSA-32A (32 MB), MSA-64A (64 MB)
- PC Card Adaptor for Memory Stick MSAC-PC2
- PC Card/Parallel Port Adaptor MSAC-PR1
- Floppy Disk Adaptor for Memory Stick MSAC-FD1

---

Your dealer may not handle some of the above listed optional accessories. Please ask the dealer for detailed information.

**Design and specifications are subject to change without notice.**

---

**Note on the supplied “Memory Stick”**

For the customers in the United States
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

For the customers in Canada
This class B digital apparatus complies with Canadian ICES-003.
Index to Parts and Controls

Refer to the pages indicated in parentheses for details.

**Front**

1. MIC (PLUG IN POWER) jack (37)
2. © (earphone) jack (13, 15)
3. MIC (built-in microphone) (12)
4. Display window (34, 65)
5. INDEX button (22-23, 29)
6. FOLDER button (12, 15, 18, 24-25)
7. DISPLAY button (29, 34)
8. STOP button (12, 18)
9. Speaker
10. OPR (operation) indicator (12, 15)
11. VOL (volume) control (15)
12. A-B REPEAT / PRIORITY button (20, 26)
13. ●REC (record) / STOP button (12, 21)
14. ■(pause) button (13, 16)
15. Jog lever (10, 15-16)
   - ▶ (PLAY/STOP), (Enter)
   - ◀ (Cue/Review)
   -  (Select)
16. HOLD lever (33)
17. MENU button (10, 27-28, 30, 35-37)
18. EJECT lever (11)
19. ERASE button (17-18, 24, 29)

**Rear**

20. Hook for handstrap (not supplied)
21. PLAY SPEED selector (19)
22. MIC SENS (microphone sensitivity) selector (13, 14)
23. VOR selector (14)
24. DC IN 3V jack (9)
25. Battery compartment (9)
26. Memory Stick window
27. Memory Stick slot (11)

**Display Window**

Remaining memory indication (14)
Repeat indicator (20)

Battery Indicator (9)
Information indicator
* If there is no inserted "Memory Stick" in the unit, “ALARM”, “FOLDER NAME”, “MSG. NAME”, and “FORMAT” menu items will not be displayed in the menu mode.
Index

**A**
- A-B Repeat 20, 48
- Accidental operation 33
- Adding
  - Folder 24, 52, 54
  - Index 22
  - Message 52
- Advanced VOR 14
- Alarm 30, 55

**B**
- Battery 9
- Beep 36
- Built-in microphone 12

**C**
- Clock setting 10
- Connecting external microphone 37
- Connecting other equipment 37
- Continuous playback 37
- Counter display 34
- Cue 16, 47

**D**
- Date Setting 10
- Delete
  - Folder 24, 54
  - Messages 17, 54
- Display window 68
- Display mode 34
- Drive 43, 44
- Drive box 44

**E**
- Edit menu 58
- Erase
  - Index 23
  - Error messages 57
- Extension (files) 5, 50
- External microphone 37

**F, G**
- Fast forward 16, 47
- Fast backward 16, 47
- File menu 57
- File size 39
- Floppy disk adaptor 42
- Folder
  - Adding 24
  - Deleting 24, 54
  - Labeling 27, 54
  - Moving 54
- Folder list box 44
- Folder structure 42
- Format 35

**H, I, J, K**
- Help menu 58
- Hold 33
- House current 9
- ICS files 50
- Index
  - Adding 22
  - Erasing 23
- Install
  - Software 40

**L**
- Labeling
  - Folders 27, 54
  - Messages 28, 54
- LP mode 36

**M, N**
- Main window 44
- “Memory Stick” 5
  - Inserting 11
  - Folder structure 42
  - Formatting 35
- “Memory Stick Voice Editor” software 38
  - Install 40
  - Quit 43
  - Start up 43
  - Uninstall 41
- Menu 10, 27-28, 30, 35-37
- Menu commands 44, 57
- Menu map 69
Message
  Adding 52
  Deleting 17, 54
  Labeling 28, 54
  Moving 25, 54
  Playback 15, 46
  Recording 12
Message files 42
Message list box 45
Message list file 42
Message number 12, 15
Microphone
  Built-in 12
  External 37
  Connecting 37
  Sensitivity 13
Moving
  Messages 25, 54
  Folders 54
MSF files 42
MSV files 50

O, P, Q
Online help 8
Overwrite 21
Pause 13, 16, 47
PC card adaptor 41
PC card/Parallel port adaptor 42
Play back continuously 37
Playback 15, 46
Playback Pause function 16
Playback speed 19
Player Section 45
Plug in power 37
Priority Mark(s) 26, 56
Quitting
  Software 43

R
Recorded date and time 34
Recording 12
Recording mode 36
Remaining memory 14
Remaining time 34
Repeat play 20, 47
Replacing 52
Restoring, VOICE folder 52
Review 14, 16, 47

S
Save
  As other file types 49
  By dragging and dropping 49
  Folder or message 48
  Using “Save“ dialog box 49
  VOICE folder 50
Scanning play 19
Sorting, messages 55
SP mode 36
Starting up
  Software 43
System limitations 64

T, U, V, W, X, Y, Z
Toolbar 44, 59
Troubleshooting 61
Uninstall
  Software 41
View menu 58
VOICE folder 42
  Restoring 52
  Saving 50
  Structure 42
Volume control 15, 47
VOR 14
WAV files 51